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Fig. S1. Optimization of LAMP reaction buffer components for amplification of the β-
actin housekeeping gene and high-risk HPV targets. Scatter plots show the effect of 
varying concentrations of KCl (a–c), ammonium sulfate (NH4)2SO4 (d–f), and Tween-20 
(g–i) on LAMP amplification performance for β-actin (a, d, g), HPV-16 E6 (b, e, h), and 
HPV-18 E6 (c, f, i) targets. Positive controls (red circles) containing 1,000 copies µL⁻¹ 
of target DNA and no-template negative controls (blue circles) were measured in 
triplicate (n = 3) for each condition. Individual data points are shown, with error bars 
representing the mean ± standard deviation. The optimal concentration of each buffer 
component, selected based on maximal amplification efficiency and minimal nonspecific 
background, is indicated by a black square. These optimized conditions were used for 
subsequent on-cartridge LAMP experiments.



Fig. S2 Clinical sample collection, lysis, and on-cartridge processing for extraction-free 
HPV detection. (a) Lysis efficiency of the optimized extraction-free buffer in clinical 
cervical swab samples, demonstrating effective disruption of cellular material and release 
of nucleic acids. (b) Representative appearance of HPV-positive clinical samples 
immediately after collection in Viral Transport Medium (VTM) and following lysis 
treatment. (c) Photograph of the integrated microfluidic device used for on-cartridge 
processing and amplification, incorporating the heating module and cartridge holder for 
controlled LAMP reactions. (d) A batch of collected clinical cervical swab samples was 
prepared for on-cartridge analysis, illustrating the scalability, uniformity, and 
consistency of the sample handling workflow prior to testing.



Fig. S3. Schematic representation and components of the temperature control system: (a) 
Circuit diagram showing the basic wiring and connections for thermal regulation; (b) Digital 
temperature controller (CT325) responsible for monitoring and maintaining the set 
temperature; (c) Flexible film heater (MINCO HK69002149, 10 mm × 30 mm) used to 
uniformly heat the amplification zone from both top and bottom sides.



Fig. S4. Schematic of the integrated microfluidic system for HPV-16 and HPV-18 DNA 
detection. The system performs on-chip isothermal amplification using a LAMP reaction at 65°C, 
facilitated by a compact heating module. Labelled amplicons are then directed to an integrated 
lateral flow strip, where genotype-specific capture lines enable visual identification of HPV-16 
and HPV-18 within 60 minutes. The closed, portable design supports contamination-free, point-
of-care diagnostics.



Fig. S5. Schematic layout and dimensions of the fabricated microfluidic cartridge. (a-i) The 
figure displays the top-to-bottom layer arrangement and highlights the key functional zones, 
including the sample inlet (I), a separation channel for cellular debris (O), and a dedicated 
chamber for purified nucleic acid collection (S). Each section is annotated with precise 
dimensions, illustrating the structural design necessary for efficient fluid routing, waste 
removal, and nucleic acid isolation within the compact cartridge footprint.
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Fig. S6. Time-dependent on-cartridge detection performance of the integrated LAMP–
LFA platform for high-risk HPV genotypes. Red data points represent HPV-16–positive 
samples, and blue data points represent HPV-18–positive samples. Ten no-template 
controls (NTCs) and low-copy target samples (1 copy and 10 copies µL⁻¹) were evaluated 
at different amplification times (10, 20, 30, and 40 min). For HPV-16 at 10 copies µL⁻¹, 
positive detection was observed in 4 out of 10 samples after 10 min, 6 samples after 20 
min, 8 samples after 30 min, and all samples after 40 min of amplification. In contrast, 
HPV-18 samples achieved 100% positive detection after 40 min. These results 
demonstrate a clear time-dependent increase in detection efficiency, establishing 40 
minutes as the optimal amplification time for reliable on-cartridge LAMP detection of 
both HPV-16 and HPV-18.
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Fig. S7 Temperature-dependent on-cartridge detection performance of the integrated 
LAMP–LFA platform for high-risk HPV genotypes. Red data points correspond to HPV-
16–positive samples, while blue data points represent HPV-18–positive samples. Ten 
samples were tested on a single cartridge at different heating chip temperatures (61, 63, 
65, and 67 °C). For HPV-16, positive detection was observed in 6 out of 10 samples at 
61 °C, 9 out of 10 samples at 63 °C, and in all 10 samples at both 65 °C and 67 °C. For 
HPV-18, 6 out of 10 samples were positive at 61 °C, 7 out of 10 samples at 63 °C, and 
all samples were positive at 65 °C and 67 °C. These results demonstrate a clear 
temperature-dependent increase in amplification efficiency, establishing 65 °C as the 
optimal temperature for reliable on-cartridge LAMP detection of both HPV-16 and HPV-
18.



Fig. S8 Analytical characterization of the off-cartridge real-time PCR (qPCR) assay used 
as a reference method for HPV detection. Normalized fluorescence amplification curves 
are shown for serially spiked control DNA copies/µL targeting (a) the HPV-16 E6 gene 
and (b) the HPV-18 E6 gene. Samples containing higher DNA copies/µL exhibited 
earlier amplification and lower cycle threshold (Ct) values, reaching the fluorescence 
threshold in fewer PCR cycles, whereas lower copies/µL required more cycles to reach 
the threshold. These results confirm the expected inverse relationship between the Ct 
value and initial DNA concentration, validating the qPCR assay as a quantitative 
benchmark for comparison with the on-cartridge LAMP platform.
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Fig. S9 Semi-quantitative characterization of on-cartridge LAMP amplification kinetics 
for HPV and internal control gene targets. (a) Threshold amplification times measured 
for serially spiked DNA copies/µL targeting the HPV-16 E6 gene, showing a progressive 
decrease in threshold time with increasing template concentration. (b) Calibration plot 
correlating threshold amplification time with the logarithm of HPV-16 E6 DNA 
copies/µL , exhibiting a strong linear relationship described by Y = −2.80X + 37.73. (c) 
Corresponding threshold amplification time data for the HPV-18 E6 gene, demonstrating 
a similar concentration-dependent trend. (d) Threshold time versus log DNA copies/µL  
calibration plot for HPV-18 E6, following the linear equation Y = −2.80X + 39.65. (e) 
Threshold amplification time analysis for the β-actin housekeeping gene under identical 
on-cartridge reaction conditions, confirming consistent amplification kinetics across 
targets. (f) Calibration plot of threshold amplification time versus log DNA copies/µL 
for β-actin, described by the linear equation Y = −2.80X + 40.29. Error bars represent 
the standard deviation of three independent experiments. Collectively, these results 
demonstrate a linear decrease in threshold amplification time with increasing DNA 
copies/µL across HPV and internal control gene targets, supporting the semi-quantitative 
capability and reproducibility of the integrated microfluidic LAMP platform.
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Fig. S10 Specificity evaluation of LAMP primer sets for β-actin, HPV-16, HPV-18, and 
HPV-45 using 1,000 copies of target and non-target nucleic acid templates to assess 
cross-reactivity. Data points are color-coded according to the nucleic acid template used: 
purple represents β-actin DNA, magenta represents HPV-16 DNA, cyan represents HPV-
18 DNA, and light magenta rose represents HPV-45 DNA. The x-axis denotes different 
primer–template combinations tested to assess assay specificity. The first column 
corresponds to β-actin primers with no-template control (NTC), the second column 
shows β-actin primers with β-actin–positive DNA, the third column represents β-actin–
positive DNA tested with HPV-16 primers, the fourth column shows β-actin–positive 
DNA tested with HPV-18 primers, and the fifth column represents β-actin–positive DNA 
tested with HPV-45 primers. Similarly, HPV-16 and HPV-18 primer sets were tested 
against their respective target DNAs as well as non-target HPV templates. Specific 
amplification was observed only when each primer set was paired with its corresponding 
target nucleic acid, while no cross-reactivity or nonspecific amplification was detected 
with non-target templates. These results confirm the high specificity of the β-actin, HPV-
16, and HPV-18 LAMP primer sets.



       

 Fig. S11 Quantitative image analysis using ImageJ. The original image was converted to a 
32-bit format and subsequently inverted to enhance contrast. The processed image was saved in 
JPG format and reloaded for analysis. A specific rectangular region of interest (ROI) was 
selected, and measurements were obtained using ImageJ’s measurement tool after setting the 
desired parameters.



Table S1. Primer Sequences for HPV-16 E6 and E7, HPV-18 E6 and E1 gene, HPV-
45L1 and Human β-Actin Gene

HPV-16-E7 Sequences

Label Length Sequence 5’-3’

16 e7F3 19 AACAAACCGTTGTGTGATT

16 e7B3 8 TCAGTTGTCTCTGGTTGC

16 e7FIP 47 ATCTTTGCTTTTTGTCCAGATGTCTGTGTATTAACTGTCAAAAGCCA

16 e7BIP 5 BIOTIN-GGTCGATGTATGTCTTGTTGCAGACAATGTAGGTGTATCTCCATG

16 e7LB 5 FITC PROBE-TCAAGAACACGTAGAGAAACCCAGC

HPV-16-E6 Sequences

16 e6F3 19 ATGCACCAAAAGAGAACTG

16 e6B3 20 AGCATATGGATTCCCATCTC

16 e6FIP 39 BIOTIN-GCAGCTCTGTGCATAACTGTCAATGTTTCAGGACCCACA

16 e6BIP 41 AGAATGTGTGTACTGCAAGCAATCCCGAAAAGCAAAGTCAT

16e6LF 21 GGTAACTTTCTGGGTCGCTCC

16e6LB 20 CAGTTACTGCGACGTGAGGT

16 e6FITC-
PROBE

23 AACAACTATACATGATATAATAT

HPV-18-E6 Sequences

18 e6F3 23 AAAAACTAACTAACACTGGGTTA

18e6B3 18 ACTTGTGTTTCTCTGCGT

18 e6FIP 47 GGTGTCTAAGTTTTTCTGCTGGATAATTTATTAATAAGGTGCCTGCG

18 e6BIP 41 BIOTIN-CGACGATTTCACAACATAGCTGG-GTTGGAGTCGTTCCTGTC

18 e6LB 21 FITC-CATTCGTGCTGCAACCGAGCA

HPV-18-E1 Sequences

18 e1F3 19 CAGGGTCGGATATGGTAGA

18 e1B3 18 TTGCCTTTTTCTGCCCAC

18 e1FIP 42 CATCATTGTGGACCTCCTGCG-CACAAGGAACATTTTGTGAAC

18 e1BIP 39 BIOTIN-CGAAAGTTTGCAGGAGGCAGAACCGTGGACTTAACTCTG

18 e1LF 19 FITC-GCTGTCTCTAGCTCTGCCT

18 e1LB 23 CACAGAAAACAGTCCATTAGGGG

HPV-45-L1 Sequence

45 L1F3 23 GGCCATGGTATTATTATTTTCCT



45 L1B3 23 CCTAAAATATGGATTGCCTACAG

45 L1FIP 41 ACCGTACTGTCACTAGGCCG-AAAAACGTAAACGTATTCCCT

45 L1BIP 43 ATCTTCCACCACCTTCTGTGG-TGCATGATAAAATATGCTTGTG

45 L1LF 22 CCACAAAGCCATCTGCAAAAAA

45 L1LB 21 CCAGAGTTGTCAGCACTGATG

Human β-actin reference genome sequence (NM_001101.5)

act1F3 19 GGCATCCTCACCCTGAAGT

act1B3 20 TGGGGTGTTGAAGGTCTCAA

act1FIP 41 Biotin-GCCACACGCAGCTCATTGTAGA-CATCGAGCACGGCATCGTC

act1BIP 38 AGCACCCCGTGCTGCTGA-GGTCATCTTCTCGCGGTTGG

act1LF 22 FITC- TCTCCATGTCGTCCCAGTTGGT

Table S1 outlines the genomic coordinates, region lengths, and nucleotide sequences of 

the primers designed for amplifying the E6 gene (associated with HPV-16 and HPV-18) 

and the human β-actin gene, which serves as an internal control. This comprehensive 

dataset ensures precise targeting and efficient amplification for downstream molecular 

assays, such as LAMP, in HPV detection workflows.

Table S2. LAMP + lysis + LFA consumables (per test)

Module Component (example 
supplier)

Pack price 
(currency)

Pack 
size

Assumed use 
per test

Cost per test 
(USD)

LAMP Bst 3.0 DNA polymerase 
(NEB list price) 

$343.00 8000 U 8 U 0.34

LAMP Isothermal Amplification 
Buffer II (10X) 

$32.00–
$33.00

6 mL 3.5 µL 0.02

LAMP dNTP mix 10 mM each 
Thermo Fisher Scientific

$132.65 1 mL 4.9 µL 0.65

LAMP Betaine 5 M (molecular 
biology grade) Thermo Fisher 
Scientific

$41.65 10 mL 5.6 µL 0.02

LAMP Primers (6 oligos; pricing 
basis) IDT DNA

$0.45/base 25 
nmol 
scale

per LAMP 
stoichiometry

0.33 
(estimated)

LAMP 
subtotal

1.36

https://www.thermofisher.com/order/catalog/product/R0192?utm_source=chatgpt.com
https://www.thermofisher.com/order/catalog/product/J77507.UCR?utm_source=chatgpt.com
https://www.thermofisher.com/order/catalog/product/J77507.UCR?utm_source=chatgpt.com
https://www.idtdna.com/pages/products/custom-dna-rna/dna-oligos/custom-dna-oligos?utm_source=chatgpt.com


Lysis Proteinase K 20 mg/mL 
Thermo Fisher Scientific

$107.65 1.25 
mL

10 µL 0.86

Lysis Guanidine HCl (≥99%) $324.00 500 g 0.191 g 0.12

Lysis Triton X-100 MilliporeSigma $61.70 100 mL 10 µL 0.01

Lysis Tween-20 MilliporeSigma $47.60 100 mL 1 µL <0.01

Lysis Tris base MilliporeSigma $256.00 1 kg 0.0012 g <0.01

Lysis subtotal 0.99

LFA HybriDetect universal LFA kit 
(100 tests) Milenia Biotec

€250.00 100 
tests

1 test 2.93

Chemistry + 
LFA subtotal

5.28

Table S3. Cartridge raw materials (example costing)

Cartridge item Example price 
source

Pack 
price

Pack size Assumed yield Material cost per 
cartridge (USD)

PMMA/acrylic sheet 
(3 mm)

Etsy listing $11.41 12"×19" 6 cartridges/sheet 1.90

3M 9474LE / 300LSE 
PSA (10 sheets) 

Retail listing $79.95 10 × 
(12"×12")

10 cartridges/sheet-
equivalent

0.80

Transparency film 
(100 sheets) 

Quartet/Apollo $33.09 100 sheets 20 cartridges/box 0.17

Cartridge materials 
subtotal

2.87

Table S4. One-time device cost (heater + controller + sensor + PSU)

Device item Example price 
source

Unit 
price

Qty One-time cost 
(USD)

Minco polyimide heater HK6900 Minco Minco catalog $111.00 2 222.00

Minco CT325 controller (Pt100 input) 
Minco

Minco catalog $187.00 1 187.00

Pt100 3-wire RTD sensor Evolution 
Sensors and Controls

EvoSensors $50.00 1 50.00

12 V / 5 A PSU (example: Mean Well LRS-
60-12 listing) eBay

Retail listing $49.82 1 49.82

Estimated one-time device subtotal 508.82

https://www.thermofisher.com/order/catalog/product/AM2546?utm_source=chatgpt.com
https://www.sigmaaldrich.com/US/en/product/sial/x100?srsltid=AfmBOooUGB9my8gYZ1j7aSnrNCWl1B3x5hsCivShHL4XG1UQvmcgPSFA&utm_source=chatgpt.com
https://www.sigmaaldrich.com/US/en/product/sigma/p2287?srsltid=AfmBOopwER1BlQHxfb53UUeQfyk-m7uTCCNkcMJ88NruW5vJK0cJtnmV&utm_source=chatgpt.com
https://www.sigmaaldrich.com/US/en/product/roche/trisro?srsltid=AfmBOor4pIL5IaHxJtomJ614Vh1sPxx3tt5eq4v1pw0Up2rGVP87LXzH&utm_source=chatgpt.com
https://www.milenia-biotec.com/en/product/hybridetect/?utm_source=chatgpt.com
https://www.minco.com/catalog/?catalogpage=product&cid=3_1-polyimide-thermofoil-heaters&id=HK6900&utm_source=chatgpt.com
https://www.minco.com/catalog/?catalogpage=product&cid=2_1_3-miniature-dc-controller&id=CT325PD2C1&utm_source=chatgpt.com
https://evosensors.com/collections/pt100-3-wire-class-a/iec-100-ohm?srsltid=AfmBOooZRdaXYMTuz8UCuNnbFn0qiJXWz__i2iFetUhs75uDv6hBrRVb&utm_source=chatgpt.com
https://evosensors.com/collections/pt100-3-wire-class-a/iec-100-ohm?srsltid=AfmBOooZRdaXYMTuz8UCuNnbFn0qiJXWz__i2iFetUhs75uDv6hBrRVb&utm_source=chatgpt.com
https://www.ebay.com/itm/266334516943?utm_source=chatgpt.com


Table S5. Comparison of HPV Detection Technologies (HPV16/18)

Method 
(Product)

Sample 
Type

Detection 
Time

Sensitivity Specificity Detection 
Method

LOD 
(copies/µL)

Multiplex Referen
ce

Integrated 
Microfluidic 
LAMP–LFA 
(This Work, 
2025)

Cervical 
swab 
(direct)

~45 min 
(sample-
to-answer)

96.8% (vs 
qPCR)

100% Isothermal 
LAMP 
amplificat
ion

~10 
copies/µL

Yes (HPV16 
& 18)

Manusc
ript 
draft

Roche Cobas 
HPV Test (PCR)

Cervical 
(liquid 
cytology)

~3–4 
hours (lab 
workflow)

~90% 
(≥CIN2)

~70% Real-time 
PCR 
(TaqMan 
probes)

150–2400 
copies/mL 
(genotype-
dependent) 
(~0.15–
2.4/µL)

Yes (14 
hrHPV 
types; 16/18 
genotyped)

14,15

Cepheid Xpert 
HPV 
(GeneXpert)

Cervical 
or vaginal 
swab

~60 min 
(cartridge)

92.3% 
(CIN2+, 
clinician)

53.3% Automate
d PCR 
(nested 
real-time)

~2.9×10^3 
IU/mL 
(HPV16) 
(~2.7×10^3 
copies/mL)

Yes 
(HPV16, 
HPV18/45, 
others 
pooled)

15–17

Qiagen careHPV 
Test

Cervical 
or vaginal 
sample

~2.5 hours 
(batch)

86.4% 
(CIN2+, 
clinician)

80.4% DNA 
Hybrid 
Capture + 
chemilumi
nescence

~1 pg HPV 
DNA 
(analytical; 
~10^5 
copies) 

No (hrHPV 
pooled 
result)

17,18

Arbor Vita 
OncoE6™ Test

Cervical 
swab 
(protein)

~2 hours 
(rapid 
test)

54.5% 
(CIN2+)

98.4% Lateral-
flow 
immunoas
say (E6 
oncoprotei
n)

– (protein 
detection; no 
DNA LOD)

Yes (HPV16 
& 18 E6 
lines)

17

Fan et al. 2020 
(Visual LAMP)

Cervical 
sample 
(DNA)

~65 min 
@ 63 °C

“Compara
ble to 
qPCR”

High 
(validated 
vs PCR)

LAMP 
(colorimet
ric, naked-
eye)

~10–100 
copies (per 
reaction)

No (separate 
16/18 
assays)

19,20

Wang et al. 2022 
(Hydrogel 
LAMP)

Cervical 
sample 
(single-
cell)

~30 min 
(rapid 
isothermal
)

“Compara
ble to 
qPCR”

High (vs 
qPCR)

LAMP in 
hydrogel 
(in situ 
cell assay)

– (single 
infected cell 
detected)

No 21

Chen et al. 2022 
(PCR–LFA)

Cervical 
sample 
(DNA)

~75 min N/R (lab 
validation)

N/R PCR 
amplificat
ion + LFA 
strip

~700 copies 
(per test)

Yes (HPV16 
& 18)

22



Martínez-Fierro 
et al. 2025 (HDA 
Microfluidic)

Cervical 
swab 
(DNA)

<60 min 
(on-chip)

95.5% 100% Helicase 
Dep. 
Amplifica
tion 
(isotherma
l)

~15 
copies/reacti
on

Yes (HPV16 
& 18)

23

Khamcharoen et 
al. 2023 (RPA 
Microfluidic)

Cervical 
DNA 
(HPV16)

~30 min 
(capillary 
chip)

N/R 
(limited 
testing)

N/R Recombin
ase Pol. 
Amplifica
tion

~0.24 pg/µL 
(~30 
copies/µL)

No 24,25

Zhao et al. 2023 
(M-D3 CRISPR 
Device)

Cervical 
sample 
(DNA)

~30 min 
(on-chip)

92.3% 100% RPA + 
CRISPR-
Cas12a 
(droplet 
microfluid
ic)

~1 
copy/reactio
n

Yes (HPV16 
& 18)

26

The present LAMP–LFA microfluidic cartridge offers a fully sample-to-answer solution 
with integrated DNA extraction, amplification, and lateral-flow readout in ~45 minutes 
– faster than most lab tests (e.g. PCR) and without complex instruments. It achieves high 
diagnostic accuracy (≈97% sensitivity, 100% specificity) on cervical swabs, with a low 
DNA detection limit (~10 copies/µL). Compared to commercial assays, this device 
requires minimal equipment (no thermocycler or centrifuge) and is highly portable and 
affordable, making it ideal for point-of-care use in resource-limited settings. Notably, it 
simultaneously detects HPV16 and HPV18, providing multiplexed results similar to 
those of laboratory-based platforms, but at a fraction of the cost and infrastructure 
requirements. Overall, the present work stands out for its rapid, integrated POC operation 
and robust performance, combining the strengths of isothermal amplification and LFA in 
a field-deployable format.

Fabrication and Design of the Electronic Circuit and Heat Control Mechanism

All electronic components were securely mounted within a custom 3D-printed cradle, 
which was integrated into the fabricated structure. The system employs a straightforward 
and compact electronic design, avoiding unnecessary complexity. At its core, the 
temperature control mechanism consists of a digital temperature controller (CT325) and 
two flexible film heaters (10 mm × 30 mm, MINCO HK69002149) positioned on both 
the upper and lower sides of the amplification zone to ensure uniform heating. (Figure 
S1) A 12 V power adapter supplies power to both the temperature controller and the 
heating elements. Temperature sensing is achieved using a 3-wire Resistance 
Temperature Detector (RTD) wired for lead resistance compensation via the controller. 
The two common RTD wires, typically the same color, are connected to terminals 6 and 
7, following standard wiring protocols, enabling precise temperature measurements. The 



RTD sensor continuously monitors the system temperature and converts it into a voltage 
signal. This signal is then compared against the setpoint defined by an internal 
potentiometer. A solid-state output transistor is triggered if the measured temperature 
falls below the setpoint, activating the heaters. Once the temperature exceeds the setpoint, 
the transistor switches off, stopping the heating process. The operational status of the 
heater is indicated by a "Heat LED," which illuminates when the heater is active. This 
minimalistic and efficient setup ensures reliable thermal regulation with minimal 
electronic complexity, making it highly suitable for low-cost, portable diagnostic 
platforms.

Chitosan Functionalization of PMMA Microfluidic Channels

Microfluidic channel surfaces were functionalized with chitosan to impart pH-responsive 
nucleic acid capture capability via reversible electrostatic interactions. Prior to chitosan 
immobilization, the fabricated PMMA microfluidic chips were cleaned by sequential 
flushing with ethanol and deionized (DI) water and dried under a nitrogen stream. 
Because PMMA is intrinsically hydrophobic and chemically inert, surface activation was 
performed to introduce polar functional groups and improve coating stability.

Chemical activation of the PMMA microchannels was first carried out using alkaline 
hydrolysis (saponification). The channels were flushed with 1 M NaOH for 20 min, 
during which hydroxide ions attacked the ester side chains (–COOCH₃) of PMMA, 
converting them into surface-bound sodium carboxylate groups (–COO⁻Na⁺). The 
channels were subsequently rinsed thoroughly with DI water and flushed with 0.1 M HCl 
to protonate the carboxylate groups, yielding stable carboxylic acid functionalities (–
COOH) on the channel walls. This treatment increased surface hydrophilicity and 
generated negatively charged sites suitable for polymer adsorption and covalent 
modification 1–3. Following chemical activation, the PMMA microchannels were further 
treated with oxygen plasma to enhance surface oxidation and improve coating 
uniformity. Oxygen plasma generates reactive oxygen species that cleave C–C and C–H 
bonds at the polymer surface, leading to the formation of additional hydroxyl (–OH) and 
carboxyl (–COOH) groups. This dual activation strategy has been shown to significantly 
increase surface energy and promote stable biomolecule attachment on thermoplastic 
microfluidic substrates 4–6. Low-molecular-weight chitosan (50–190 kDa, degree of 
deacetylation ≥75%) was dissolved at a concentration of 0.5–1.0% (w/v) in 1–2% (v/v) 
acetic acid under continuous stirring until a clear, homogeneous solution was obtained. 
The solution was filtered through a 0.22 µm syringe filter to remove undissolved 
particulates. The chitosan solution was introduced into the activated microchannels and 
incubated at room temperature for 30–60 min, allowing chitosan chains to adsorb onto 
the carboxylated PMMA surface through electrostatic interactions between protonated 
amine groups (–NH₃⁺) and negatively charged carboxyl groups (–COO⁻), as well as 
hydrogen bonding and van der Waals interactions 7–9. Excess and loosely bound polymer 
were removed by flushing the channels with acetate buffer (pH 5.0), followed by gentle 
drying. To improve coating stability, the functionalized devices were thermally cured at 
50–60 °C for 1 h. The resulting chitosan-functionalized microchannels exhibited 



pronounced pH-dependent charge-switching behavior. Under acidic loading conditions 
(pH ≤ 5.5), the protonation of chitosan's primary amine groups imparted a net positive 
surface charge, enabling the efficient electrostatic capture of negatively charged 
DNA10,11. Following nucleic acid capture, the channels were flushed with deionized 
water to remove proteins, salts, and amplification inhibitors while retaining the bound 
nucleic acids on the chitosan-modified surface. Instead of performing a separate elution 
step, the amplification reagents were introduced directly into the microchannels, and 
nucleic acid amplification was carried out in situ on the same chip. This strategy 
eliminated the need for alkaline elution, minimized sample loss, and enabled a fully 
integrated, chaotrope-free sample-to-answer workflow compatible with on-chip nucleic 
acid amplification and detection 12,13.

Quantification and Calibration of Lateral Flow Assay (LFA) Strips Using ImageJ 
Analysis

To quantify the signal intensities of the test and control lines on the lateral flow assay 
(LFA) strips, images were first captured using a smartphone under consistent ambient 
lighting to ensure uniformity across all samples. These images were then analyzed using 
ImageJ software (National Institutes of Health). Each image was opened in ImageJ, and 
rectangular regions of interest (ROIs) were manually drawn to encompass the test line, 
control line, and an adjacent background area. This ensured standardized selection for all 
measurements. The selected image regions were then processed by inverting them to 
enhance contrast (via Image > Adjust > Invert) and subsequently converted to 32-bit 
grayscale format (Image > Type > 32-bit) to enable more accurate intensity analysis. The 
average grayscale intensity of each ROI was measured using the “Measure” function 
(Analyze > Measure). This systematic image processing and analysis pipeline is 
illustrated in Figure S2, which summarizes the digital quantification methodology used 
for evaluating the LFA strip. To correct for background noise, the average intensity of 
the background ROI was subtracted from the intensity values of both the test and control 
lines. The corrected test line intensity was then divided by the corrected control line 
intensity to obtain the T/C (test/control) ratio for each strip. This T/C ratio served as the 
quantifiable metric corresponding to the concentration of the target analyte. For each 
target antigen, HPV-16 E6 or HPV-18 E6, a standard calibration curve was generated by 
plotting known antigen concentrations against their respective T/C ratios, as shown in 
Fig. S11. 

Detection Pad Surface Modification

To improve fluid transport and ensure reliable lateral flow assay (LFA) performance, the 
detection pad region of the microfluidic cartridge was surface-modified to render it 
hydrophobic. This was achieved by applying a thin, uniform coating of a commercial 
transparent nail lacquer (e.g., Sally Hansen Hard As Nails® Clear), followed by gentle 
polishing to obtain a smooth surface finish. The hydrophobic modification reduced 
surface energy, preventing the nonspecific spreading or pooling of liquid at the detection 
interface. As a result, the eluted, amplified amplicons migrated smoothly and uniformly 



across the lateral flow strip without lateral dispersion or stagnation. This simple surface 
treatment significantly improved the consistency of capillary-driven flow and signal 
clarity on the LFA, contributing to reproducible test-line development and a reliable 
endpoint readout. The use of readily available, low-cost, and transparent nail lacquer also 
aligns with the overall goal of developing a practical and scalable diagnostic platform 
suitable for point-of-care and low-resource settings.

Novelty and Key Innovations of the Integrated Microfluidic HPV Detection 
Platform

While loop-mediated isothermal amplification (LAMP) has been widely explored for 
HPV detection, the novelty of this work lies in the holistic integration of sample 
preparation, nucleic acid handling, amplification, and detection within a single 
disposable microfluidic cartridge, enabling a true sample-to-answer workflow. The 
platform uniquely incorporates a Zweifach–Fung bifurcation-based passive separation 
strategy for nucleic acid handling, eliminating the need for centrifugation, magnetic 
beads, or external pumping systems. A key innovation of this system is the integration of 
chitosan-based surface chemistry within the microfluidic channels, which enables pH-
responsive, charge-switch-mediated nucleic acid capture and inhibitor removal. 
Chitosan-functionalized, chemically activated, and plasma-treated PMMA surfaces 
selectively bind negatively charged nucleic acids under acidic conditions, while allowing 
proteins, salts, and amplification inhibitors to be washed away, thereby improving 
compatibility with downstream on-chip amplification without requiring chaotropic 
agents or separate elution steps. The cartridge further integrates on-chip LAMP with an 
embedded lateral flow assay (LFA) readout, enabling direct visual detection and reducing 
the need for user intervention. Simultaneous detection of HPV-16 and HPV-18 within a 
single cartridge addresses the most clinically relevant high-risk human papillomavirus 
(HPV) genotypes. Finally, the use of a compact, low-power isothermal heating module 
supports portability and operation in low-resource settings. Collectively, the integration 
of passive microfluidics, chitosan-mediated nucleic acid handling, isothermal 
amplification, and on-chip lateral flow detection distinguishes this platform from existing 
LAMP-based HPV assays that rely on multiple off-chip or laboratory-dependent steps.

Cost and Practical Feasibility for Low-Resource Deployment

To assess the suitability of the proposed microfluidic LAMP–LFA platform for 
deployment in low-resource and decentralized clinical settings, a detailed cost analysis 
was performed covering assay reagents, consumables, and device fabrication. Based on 
current market pricing and laboratory-scale fabrication, the cost of LAMP reagents per 
test is approximately USD 1.3–1.6, while the room-temperature lysis buffer contributes 
an additional USD 0.9–1.0 per sample. The disposable multilayer microfluidic cartridge, 
fabricated from laser-cut PMMA, pressure-sensitive adhesive, and transparency films, 
has an estimated material cost of USD 2.5–3.0 per unit under small-batch production, 
with substantial scope for further reduction upon scale-up using injection molding or roll-
to-roll lamination. Consequently, the total consumable cost per test is approximately 



USD 5–6. The reusable heater and control module, comprising thin-film heaters, a digital 
temperature controller, an RTD sensor, and a power supply, has a one-time cost of 
approximately USD 450–550 and can be reused for several thousand assays, resulting in 
a negligible amortized per-test cost, and this information is added in the manuscript in 
section 2.8. In comparison with PCR-based HPV testing and commercial cartridge 
platforms, which typically require USD 15–50 per test along with sophisticated 
instrumentation and trained personnel, the proposed system offers a substantial reduction 
in cost while maintaining high diagnostic performance (96.8% sensitivity and 100% 
specificity) and a rapid sample-to-answer time of ~45 minutes. These features 
demonstrate the platform's strong potential for large-scale cervical cancer screening in 
resource-limited settings, including primary health centers, community clinics, and 
outreach screening programs.
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